
Réalisation de lierre de parement
_______________________________

Parfois, alors que l'on vient de finir la réalisation particulièrement ardue d'un édifice, d'un mur ou de 
tout autre élément en matières pérennes, nous reste un sentiment d'innachevé, que notre création manque de  
"bucolique".

Pas de panique, il existe une solution simple et rapide pour remédier à ce petit soucis esthétique. Je 
vais vous guider afin de réaliser le parement idéal à tous les murs de pierre : un beau lierre centenaire !

1. Première étape : modélisation d'une feuille

Tout d'abord, Ouvrez une nouvelle scène (ou prenez celle que vous désirez orner), selectionnez un  
calque vide (mais si, vous savez, la barre des calques, c'est ça : ) et ajouter dans ce 
dernier un plan (Add > Plane). Pour plus de comodité, nous le tourneront de manière à ce qu'il soit normal 
à l'axe Y ( R – rotate : tourner - > X > 90) [il suffit pour cela de taper 90 sur le pavé numérique].

A présent  que  vous  avez  votre  plan  bien  face  à  vous,  normal  à  la  vue (touche  1  du  pavé 
numérique),  selectionnez,  en mode "edge selection" (sélection des arrêtes,  le  bouton en bas de l'écran 
représentant  un  cube  dont  seulement  une  arrête  est  sélectionnée)  les  deux  arrêtes  horizontales  puis 
subdivisez-les deux fois à  l'aide de la  touche W puis  immédiatement  de la  touche F6.  Définissez le 
number of cuts (nombre d'incisions) à "2". Puis, ainsi que présenté sur l'image, sélectionnez les deux arrêtes 
apparues puis appuyez sur S (scale : redimentionner) > X (pour contraindre le mouvement sur l'axe X) et 



faites glisser jusqu'à obtenir l'apparence qui suit :

Sélectionnez à  présent,  sur  le  segment  horizontal  le  plus  haut,  les deux vertices du milieu 
(celles que vous venez de rapprocher et extrudez-les à l'aide de E (extrude) > Z (pour contraindre l'extrusion 
vers  le  haut)  (figure  1).  Une  fois  que  vous  avez  obtenu  cette  excroissance,  re-passez  en  mode  "edge 
selection"  (sélection  d'arrêtes),  sélectionnez  les  deux  arrêtes  verticales de  cette  dernière  et 
subdivisez-les 3 fois à l'aide de W, de la même manière que précédemment. (figure 2)

J'aime bien ce moment. Il est particulièrement ignoré de beaucoup de monde et pourtant, c'est un  
outil très pratique. C'est l'outil "To Sphere" qui permet de courber n'importe quel mesh autour d'un point de 
pivot que vous aurez défini.  Plus le point de pivot sera proche du mesh, plus celui-ci aura un rayon de 
courbure faible et plus il sera resserré sur lui-même.

Placez-vous à présent en vue de profil (les touches du pavé numérique servent à aller rapidement 
d'une vue à l'autre). Cliquez avec le bouton gauche de la souris pour placer le point de pivot (le reticule 
rouge et blanc) un peu en retrait de votre plan, comme indiqué sur l'illustration suivante. Assurez-vous 
bien que le pivot est choisi comme référentiel de votre espace de travail (changez, en bas de votre vue 
3D, les deux cercles blancs pointés de bleu et remplacez-les par une icône représentant une croix blanche  
nantie d'un cercle en son centre).

Appuyez  simultanémment  sur  Maj + Alt  +  S (ou  dans  le  menu  Mesh > Transform > To 
Sphere) puis faites glisser jusqu'à ce que votre mesh soit arrondi autour de votre point de pivot.



Et maintenant commence la "subdivision en folie". Placez-vous en  vue de face, en mode "edge 
selection" (sélection d'arrêtes). Nous ne nous occuperons à présent que de ce qui fut notre plan de base en  
oubliant l'excroissance. Sélectionnez donc toutes les arrêtes verticales de ce plan (figure 1). A l'aide de 
W (subdivision  surface  :  subdiviser  une  surface),  faites  trois  subdivision fractale de  ces  arrêtes  en 
définissant grâce à la touche F6, le "number of cuts" à 3 et le modifier "fractal" à 15 ( figure 2).

Sélectionnez maintenant  les  arrêtes  horizontales  externes de  votre  plane  (comme indiqué 
figure 3) puis subdivisez-les une fois avec le même coefficient de fractale (figure 4)



Voici une belle chiffonade. Re-passez en mode "vertice Selection" (sélection par points). N'hésitez 
pas, à l'aide de G (Grabe : déplacer) > X ou Y à déplacer certains points qui en chevaucheraient d'autres. Un 
outil très pratique aussi du panneau "Mesh", en bas de l'écran, est la fonction "Smooth Vertex" (Mesh > 
Vertices > Smooth Vertex). Je vous conseille de l'utiliser au moins une fois sur l'ensemble du mesh que  
vous  venez  de  créer  pour  le  rendre  moins  cahotique.  Appliquez  aussi  d'ores  et  déjà  un  "smooth"  sur 
l'ensemble de votre mesh pour le rendre plus doux. Donnez-lui un nom que vous pourrez retrouver.

1. Deuxième étape : Alpha et texture

Nous allons à présent passer à ma partie préférée : le texturing.  Scindez votre écran en deux 
parties en tirant vers la gauche les petites hachures au coin supérieur droit de votre écran. A l'aide du menu  
déroulant de cette nouvelle fenêtre (en bas à gauche), passez en mode UV/Image editor.

Je me dois de vous expliquer plus ou moins brièvement la procédure. Nous allons avoir besoin à 
présent de deux textures : un masque, en noir et blanc qui se chargera de rendre transparent la partie de la 
sélection qui ne sera pas la feuille et une autre image, en couleur cette fois, qui se chargera de donner ses 
formes et ses couleures à la feuille. Les textures que j'ai utilisé sont les suivantes :

 < Texture en Alpha
 (noire et blanche)

 Texture en couleur >
récupérée sur le site cgtextures
(Faites attention pour les pros
de la botanique : le cyclamen,
ce n'est pas du lierre !)

Dans l'idéal, créez votre propre texture sous Gimp par exemple. Il n'est absolument pas utile, comme 
je l'ai fait, de détourer la seconde image puisque la texture en alpha s'en chargera mais c'est vrai que c'est  
plus évident de faire le détourage lorsque l'on veut obtenir l'alpha comme je l'ai fait.

Revenons à nos moutons. Dans votre panneau UV/Image editor, cliquez sur Image > Open (Alt 
O) puis chargez dans la vue la première image, celle en Alpha. La seconde étant la copie "con-forme" de la 
première, il n'est pas nécessaire de la charger. Une fois cela accompli, sélectionnez, en vue de face votre 
mesh puis pressez la touche U (Unwrap : déplier) puis sélectionnez Projet From View dans le menu.

http://www.cgtextures.com/login.php?&texid=8032&destination=texview.php?id=8032&PHPSESSID=544897aa76631d924e3be76fa5094a71


Votre dépliage n'est pas vraiment optimal. Il va falloir synchroniser tout cela afin d'obtenir, à la fin, le 
résultat de la figure 1. Pour cela, procédez par ordre. Sélectionnez toutes les vertices d'une même rangée puis  
pressez  succesivement  S  (scale  :  re-dimentionner) >  Y  (contraindre  selon  l'axe  Y) >  0  (zéro  du  pavé 
numérique pour le mettre à la même hauteur). Faites de même pour les vertices verticales mais en utilisant  
cette fois-ci S > X (contraindre selon l'axe X) > 0 comme présenté sur la figure 2.

Une fois votre mesh d'aplomb, quelques "Scale" (touche S) et "Grabe" (touche G) devraient suffire 
à obtenir le résultat escompté.

Vous pouvez à présent fermer la fenêtre UV/Image Editor de la même manière que vous l'avez 
ouverte, nous n'en auront plus besoin. Reprenez votre  Mesh en mode édition.  Sélectionnez les deux 
vertices à l'extrémité de la tige et cliquez sur l'onglet Mesh > Snap > cursor to Selected. Cela aura 
pour but de place le pivot 3D pile entre vos deux vertices.

Ensuite, passez en  mode Object puis cliquez, toujours en bas de l'ecran, sur l'onglet  Object > 
Transform > Origin to 3D Cursor.



L'origine définit le point de pivot par défaut d'un objet. Si l'on veut pouvoir utiliser ce dernier par la 
suite, il va falloir le définir au bout de sa tige, à l'endroit où il s'attache au tronc. Laisser ce point au milieu 
nous aurait donné, à terme, une feuille à cheval entre l'intérieur et l'extérieur du tronc... Pas très réaliste

Il est à présent temps d'appliquer un nouveau matériau à notre feuille. Selon la disposition de votre 
espace de travail, il devrait se trouver à droite de votre écran comme indiqué sur la figure 1. Cliquez donc sur 
l'icône Material (matériau) représenté par une boule quadrillée. Ajoutez un nouveau matériau à votre 
mesh. (figure 1). A présent apparaît le panneau de material.

Si vous ne le connaissez pas, vous pourrez vous amuser plus tard avec. Les seules valeures que nous 
avons à changer à présent sont les valeurs de specular à mettre à 0 (il est néanmoins préférable de laisser  
un peu de spéculaire, les feuilles possèdent quelques reflets tout de même) et celle de Ztransparency. Pour 
activer ce dernier, il suffit de cliquer sur la petite case pour l'activer puis de descendre  l'alpha à 0 (ce  
paramètre définit  que l'alpha que nous allons récupérer sur notre texture influencera la transparence à  
hauteur de 100%, comme si le mesh n'existait pas). Voir figure 2.

Rien n'apparaît dans l'agent d'aperçu. C'est normal, nous n'avons encore appliqué aucune texture.  
Pour ce faire, placez-vous à présent dans l'onglet texture (l'onglet à droite de l'onglet material, celui qui 
représente un échiquier rouge et blanc). Dans cet onglet, ajoutez une nouvelle texture (figure 1)

Par défaut, cette texture est un "cloud" (nuage, brouillard). Nous voulons le remplacer par une image 
aussi, au-dessous de la fenêtre dans laquelle vous avez ajouté une texture, cliquez sur le menu déroulant 
qui  affiche  "cloud"  puis  sélectionnez  dans  ce  dernier  "image  or  movie"  puis,  dans  les  onglets  qui 
apparaissent, allez dans "image" puis Open. (figure 2)

Il va vous être nécessaire de modifier quelques paramètres. Dans l'ordre de la figure 3 :  Activez 
"both" : cela permet d'avoir une vue de votre texture et d'un object mappé avec cette dernière. Dans l'onglet  
"Mapping", définissez la zone coordinates sur "UV" ce qui permettra de récupérer votre dépliage de la 
première partie et d'y appliquer la texture choisie. Dans l'onglet Influence,  Décochez la case "color" 
(car on ne veut pas d'une feuille en noir et blanc !) et activez celle d'au-dessous, "Alpha" pour récupérer le 
canal alpha (le noir sur cette image). Enfin, activez RGB to intensity dans le même onglet pour pouvoir 
observer le premier résultat : une partie de votre mesh est transparente ! (figure 3)

A présent,  créez  une  nouvelle  texture (dans  le  panneau  du  haut,  cliquez  au-dessous  de  la 



première). Lorsque c'est fait, ouvrez l'image colorée de la feuille (seconde image) puis mappez-la en UV 
dans l'onglet "Mapping", comme l'autre. (Figure 4 : vous verrez, c'est simple, ça se lit comme une BD)

Figure 1 Figure 2

Figure 3

Figure 4



Si  vous  avez  une  caméra  et  une  lamp  ou  un  sun  vous  pouvez  dès  à  présent  faire  un  rendu 
intermédiaire. Je vous en fait grâce, on obtient cela :

C'est une feuille quoi... Veillons à présent à faire la branche sur laquelle elle sera accrochée.

1. Troisième étape : Un tronc solide

Pour cela, il y a deux méthodes. Je vous parlerai surtout de la première car c'est la plus simple et  
celle qui fait le travail le plus propre. Personnellement, je n'utilise pas cette méthode. Je vous en toucherai un  
mot plus tard et vous dirai pourquoi.

Restons sur le calque de notre feuille pour commencer. En mode object, ajoutons grâce au menu 
Add > Curve > Circle,  un cercle.  Même si  ce dernier  réagit  comme un mesh (édition,  déplacement, 
réduction, rotation,...), il est géré de manière vectorielle par des fonctions définissant des courbes. C'est-à-
dire que ces cercles n'ont pas de définition minimale. On peut zoomer dessus sans jamais voir de crénelage  
ou de faces. Bref.

Vous  devriez  avoir  dans  la  barre  des  propriétés  (celle  dans  laquelle  vous  avez  trouvé  l'onglet 
"textures" et "material", une petite icône représentant un cube en 3D. Cliquez dessus. Dans la première 
zone de saisi, il devrait être écrit "curve". C'est le nom de votre courbe. Changez-le en ce qu'il vous plaira, 
"section du tronc" par exemple. Je l'ai personnellement appelé CurveCircle. Pas très poétique.

Bien, à présent, revenons dans  le calque comportant notre modélisation de base. Pour ma 
part, c'est un pan de mur, tout ce qu'il y a de plus habituel. En mode objet, ajoutons-y, de la même manière  



que nous avons ajouté notre cercle, un path (littéralement "chemin", que vous pouvez voir trois ligne au-
dessous du circle).

Passez en mode édition.  Les  mêmes  règles  qu'un mesh s'appliqunet  à  lui.  Cette  ligne brisée 
représente les points par lesquels votre chemin passera. D'ailleurs, ce dernier est représenté entre eux. Vous  
pouvez subdiviser (W) cette ligne si vous avez besoin de plus de points ou bien l'extruder (E) pour l'allonger. 

Tracez un beau chemin pour définir le passage du tronc de votre lierre grimpant en n'hésitant pas 
à faire aller l'extrémité dans des coins perdus.

Attention cela dit : il faut Impérativement que votre path soit dirigé vers le bas (ce dernier est 
muni de flèches qui vous indiquent le sens du path), les flèches pointant le sol. La partie la plus évasée du  
tronc se trouvera à cet endroit. (figure 1)

Une fois que cela est  fait,  toujours dans le  panneau propriétés (à côté  de material,  textures, 
object,...), une nouvelle icône est apparue : curve. Cliquez dessus. Il s'agit à présent d'appliquer la section 
de votre tronc le long de votre chemin. Rien de plus simple ! Dans l'onglet geometry, remplissez les deux 
zones de saisies (menu déroulant en fait) avec le nom de votre cercle précédemment formé ("section du 
tronc" ou, ici, comme je vous l'avais dit "Curve-circle"). Admirez le résultat !

Pour être très précis, "bevel object" permet d'appliquer un chemin à votre forme, sans modification 
de sa section. "Taper object" quant à lui,  utilise la fonction servant à créer votre cercle pour définir les  
modifications sur la section de la courbe. C'est très rigolo. Si vous avez un peu de temps, créez une courbe de  
bézier que vous appelerez "toto" par exemple et sélectionnez "toto" Dans "Tapper Object". Amusez-vous à  
re-dimensionner la courbe, à en faire tourner les extrémités,... Vous verrez, votre tronc suivra, arborant les  
formes les plus improbables !

Bref, fini de jouer. En mode édition de votre tronc, vous pouvez ajouter autant de ramifications 
que vous le souhaitez. Cela dit, si vous souhaitez une section de tronc différente (plus petite, plus grosse),  
il vous faudra retourner dans votre second calque et créer un autre cercle différent du premier pour répondre  
à cette demande ou jouer, comme je viens de vous l'apprendre avec une courbe de bézier ou un path que vous 
modifierez et appliquerez dans "Taper Object".

Il est nécessaire de le faire maintenant, la prochaine étape vous empêchera de revenir en arrière (et  
c'est entre-autre pour cela que je n'utilise pas cette fontion, pratique et rapide mais peu commode par la suite)



1. Quatrième étape : Relier les membres au tronc 

Vous disposez à présent d'un tronc et de feuilles. Mais l'un sans l'autre, ça fait un peu minable. Aussi 
va-t-il falloir les relier. Nous allons pour cela utiliser les particules de blender.

Pour le moment, ce n'est pas possible. En effet, on ne peut fait pousser des particules sur une surface 
définie par des courbes aussi faut-il convertir notre tronc en mesh (voilà l'étape qui me fait préférer l'autre 
solution).

Pour cela, passez en mode object (Tab), sélectionnez votre tronc puis appuyez simultanément sur 
Alt + C. Un menu apparaît dans lequel vous sélectionnerez "Mesh from Curve/Meta/Surf/Text".

J'arrête ce tuto quelques minutes pour faire une remarque. Si vous passez en mode édition à présent (Tab),  
vous allez voir  un mesh saturé,  extrêmement serré.  C'est  l'inconvénient des courbes et  de leur utilisation pour ce  
système-ci. Ajouté à cela le fait qu'une fois convertie en mesh, on ne puise plus modifier la courbe (et donc ajouter des  
ramifications).

Personellement, c'est plus lent mais j'utilise la bonne vielle méthode de l'extrusion à partir d'un cercle de 6  
faces auquel j'applique un smooth. Un grabe, un rotate et un scale pour déplacer, faire tourner et réduire les extrusions.  
L'avantage est que les parties ainsi créées sont recopiables et réutilisables !

Vous avez à présent accès au panneau des particules, ces jolies étoiles jaunes dans le panneau des  
propriétés, à côté de material/textures/curves/object,... Cliquez sur ces dernières puis sur le signe "+" 
pour ajouter un système de particules.



Ca semble complexe mais ça ne l'est pas vraiment. Définissez tout d'abord le type d'emission sur  
Hair (cheveux,  poils,...).  La réglette "seed : 0" à côté permet de régler  la "graine" pour l'implantation 
aléatoire des poils par la suite.  Réglez-là sur ce que vous voulez ou laissez-là à zéro. Si l'implantation 
future ne vous convient pas, vous saurez où le trouver !

Dans l'onglet Emission, Amount signifie la quantité de poils que vous aurez. Pour un petit lierre, 
100 peut suffire, pour un entrelas complexe, 5000 peuvent être nécessaires. Ce sera en fonction de votre  
jugement esthétique. C'est modifiable à n'importe quel moment.

Cochez Random. Cela permettra une distribution semie aléatoire (en fonction de la graine et des 
normale du tronc) de poils sur votre tronc.

Descendez  jusqu'à  l'onglet  Render puis  cochez  le  bouton  "object".  C'est  ce  qui  va  nous 
permettre de remplacer ces poils disgratieux par notre objet précédemment créé. Si vous ne l'avez pas encore  
nommé, retournez le chercher et,  à l'aide de l'onglet "object" du panneau propriétés,  appellez ce mesh 
"feuille" ou "leaf" par exemple.

Dans la case "dupli object" qui est apparue lorsque vous avez coché le bouton object, rentrez le 
nom de votre feuille donc leaf ou feuille.

Bon,  c'est  pas flagrant  et  comme vous pouvez le remarquer,  c'est  très moche.  Il  va donc falloir  
remédier à cela. Je vais vous apprendre une petite manipulation utile pour ouvrir deux calques en même 
temps. Vous vous rapellez de la barre de claques ? :

Et bien pour ouvrir un second calque sans fermer le premier, maintenez enfoncé Maj et cliquez sur 
les  calques  à  ouvrir.  N'ouvrez pour  ce  procédé  que  le  calque  contenant  votre  feuille  et  celui 
contenant votre tronc. Vous avez à présent le tronc et la feuille à côté.

En mode object, jouez avec la feuille, notamment en la réduisant (S : Scale), la faisant tourner 
sur l'axe Z (R > Z), sur l'axe Y (R > Y). Déplacer la feuille n'a pas d'incidence puisqu'elle réagit en fonction 
de son point de géometrie.

Petit indice : La réduction du modèle entraînera une réduction de la taille des particules. La rotation 
sur Z permettra de faire tourner les feuilles sur l'axe du tronc, ce qui est plutôt appréciable. La rotation sur X 
(ou Y en fonction de la place du "gabarit" permettra de coller les feuilles au tronc ou de les en relever.

Testez la version la plus esthétique pour vous :



Si vous trouvez les pousses trop pales, retournez dans l'onglet texture après avoir sélectionné votre 
feuille et, dans l'onglet "colors" de la seconde texture (celle colorée), réglez la réglette saturation sur [2] 
et  contraste sur [1,5].  Vos  feuilles  auront  alors  exactement  la  même  teinte  que  celle  de  mon  rendu 
intermédiaire.

Il est possible de jouer avec une infinité de paramètres pour organiser ce lierre de meilleure manière, 
je vous laisse reprendre le tutoriel à l'envers pour jouer avec les particules, les courbes, les couleures pour 
avoir le meilleur résultat possible au final. Un exemple de ce que l'on peut réaliser avec cette méthode :

Bonne chance pour ce tutoriel, en espérant qu'il ait pu répondre à vos attentes !

______________________________________________

Tuto réalisé par Florian (Bordelor) du BlenderClan


